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RX64M Group RO1AN2144E30100
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RX Driver Package User’'s Manual Sep 1, 2014

Introduction
This application note documents the RX64M Group RX Driver Package User’s Manual, version 1.00.

The RX Driver Package is a software platform that collects middleware and drivers that support the Firmware
Integration Technology (FIT). This package provides an environment for conveniently evaluating the rich set of
peripheral functions provided by RX microcontrollers.

The RX Driver Package includes device drivers for the peripheral modules included in RX microcontrollers,
middleware developed for RX microcontrollers, a variety of interface modules, and the Board Support Package (BSP).
Users can freely combine the modules included in the RX Driver Package construct systems simply by creating
applications that using those modules, and thus quickly start the evaluation process.

This document describes the RX Driver Package, the basic structures and features of RX Driver Package applications,
and the FIT modules included in this application note.

See the related documents for detailed information on using the RX Driver Package and procedures for evaluating
applications that use the RX Driver Package.

In the use to the product, to fit your environment, please careful evaluated.

Target Device
RX64M Group (Renesas Starter Kit+ RX64M)

Related Documents

e RX Family Board Support Package Module Using Firmware Integration Technology (RO1LAN1685EU)
e Firmware Integration Technology User’s Manual (RO1AN1833EU)

e RX Family Adding Firmware Integration Technology Modules to Projects (RO1LAN1723EU)

e RX Family Adding Firmware Integration Technology Modules to CubeSuite+ Projects (ROLAN1826EJ)
e The User’s Manual provided with the RX Driver Package Application.
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1. Overview

1.1 Applicability
This document applies to the RX64M Group RX Driver Package, version 1.00.

1.2 RX64M Group RX Driver Package

The RX64M Group RX Driver Package (referred to as “this package” below) is a collection of a large number of
RX64M device drivers, middleware, and other software. Application programs in a wide range of areas can be
implemented using the rich set of peripheral modules provided by the RX64M microcontroller by using this package.

1.3 Operating Environment
This package runs under the operating environment described below.

Table 1.3.1 Operating Environment

Microcontroller RX64M Group
Evaluation board Renesas Starter Kit+ RX64M
Integrated development e’ studio, 3.0.1.09 or later
environment (IDE) Or:
CubeSuite+ V2.02.00 or later
Cross tools RX Family C/C++ Compiler Package V2.01.00 or later
Emulator El, E20
RO1AN2144EJ0100 Rev.1.00 Page 3 of 31
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2. RXDriver Package

2.1 RX Driver Package Structure

The RX Driver Package is a software platform that collects the lower level software components required to develop
application programs. A wide range of applications can be developed using the RX Driver Package.

Motor and Power
supply

Connectability

Metering and
measurement

RX Driver Package

Application

Figure 2.1.1 Types of RX Driver Package Applications

The RX Driver Package consists of the BSP module, microcontroller peripheral module device drivers, middleware
(TCP/IP, file systems, and other items), and various interfaces.

RX Driver Package

l Socket I/F I I POSIX Wrapper I | RTOS Wrapper I
Interface m m m | Ether Il usB I
SRC RSPI
I MTU” H' l l RTC H S12AD ll RIIC Il CAN I
Device driver l cMT l | GPIO H s ll DMAC || o I
l Board Support g’éckage I

Note: Items marked with an asterisk are examples.

i

Figure 2.1.2 RX Driver Package Structure
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For example, as shown in the figure below, a system can be constructed by collecting the required components from
those in the RX Driver Package and providing an application program.

Example: HTTPD (Web server)

Application
(HTTPD)

A
(er——

RX Driver Package

»

Evaluation board

A system can be constructed by selecting
the required modules from the RX Driver
Package and combining them with the
application program.

Figure 2.1.3 System Construction with the RX Driver Package

Furthermore, all of these modules meet the FIT specifications and since the folder structure and API are standardized
(with a few exceptions), this structure makes it easy to swap modules in and out or to port an application to another
microcontroller.

Application Application
(HTTPD) (HTTPD)
- 3 r s
RX Driver Package RX Driver Package
for RX64M for RX6xx

rHHrH
o =

a
Here, the USB driver is g
replaced by the SD driver. :

Evaluation board Evaluation board

(RSKRX64M) (RSKRX6xx)

An application is constructed
for another RX Driver Package.

Figure 2.1.4 RX Driver Package Application Examples
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2.2 RX Driver Package Features
The RX Driver Package has the following features.

The RX Driver Package is a software platform that provides, in a single package, the device drivers and middleware
required for application program development. Renesas will proved RX Driver Packages in a timely as
microcontrollers are released.

Application programs developed on one RX Driver Package can easily be ported to the RX Driver Package for a
different microcontroller.

All the device drivers and middleware included in the RX Driver Package are either compliant with or compatible
with the FIT specifications. Thus applications that take advantage of the FIT features can be developed easily.

The RX Driver Package provides a common interface to middleware and real-time OSes. This makes it easy to reuse
software assets and to port applications between real-time OSes.

Renesas supplies “RX Driver Package Application” sample applications that, when combined with the
corresponding RX Driver Package, allow evaluation to be started immediately.

The RX Driver Package is provided without charge. All the modules in the RX Driver Package can be used without
charge, even in commercial applications.

2.3 RX Driver Package Roadmap

While the RX64M is at the head of the list for RX Driver Package provision, Renesas will deploy versions for other
microcontrollers as they are developed. Renesas furthermore plans to add new device drives and middleware in the

future.
RX64M
Ver 1.20 Under
2dd RTOS development
- wrapper  s==———e==
RX600 [ Under
| planning |
RX64M -Add remaining low level drivers ST TTTTT
Ver 1.00 -Add ssl, PDC, RIIC
-Add POSIX wrapper
: RX2xx :
RX200 1 Ver 1.00
RX100 Eidoa
y Ver1.00
| | | | |
14/2Q 14/3Q 14/4Q 15/1Q 15/2Q~
Figure 2.3.1 RX Driver Package Roadmap
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3. Structure of the RX64M Group RX Driver Package

3.1 Folder Structure
The folder structure used in this package is shown below.

When the ZIP file for this package is downloaded from the Renesas web site and decompressed, a folder of the same
name will be present and it will contain a FITModules folder, a reference_documents folder, and this document.

The FITModules folder contains the FIT modules for the modules shown in table 3.3.1 (as ZIP files and XML files).

The reference_documents folder contains the documentation for using this package in various development

environments.

-
RX64M Group RX Driver Package ZIP file
(an_r01an2144ej0100_rx64m.zip)

l

an_r01an2144ej0100_rx64m

I

)
|_PDF_|
FITModules reference_documents Application Note

(r01an2144ej0100_rx64m.pdf)
I l (This document)

| ! !
") \ P p=

E
w4 . Methods for embedding Methods for embedding
FIT Module XML FIT Module ZIP file in e studio in CubeSuite+
(r_e v xml) (e _v***.zip) (r01an1723eu0100_rx.pdf)  (r01an1826€j0100_rx.pdf)

Figure 3.1.1 Folder Structure of the RX64M Group RX Driver Package
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3.2 Module Structure
The figure below shows the types and structure of the FIT modules included in this package.

Figure 3.2.1 RX64M Group RX Driver Package FIT Module Structure
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3.3 FIT Modules

The table below lists the FIT modules included in this package.

Table 3.3.1 RX64M Group RX Driver Package FIT Modules

Type Module FIT Module Name Version
Board Support Package Board support package r_bsp 2.60
Device Driver Compare match timer (CMT) r_cmt_rx 2.30
Device Driver DMA controller (DMACA) r_dmaca_rx 1.01
Device Driver Data transfer controller (DTC) r_dtc_rx 2.00
Device Driver Ethernet controller (ETHERC) r_ether_rx 1.00
Device Driver General-purpose 1/0 r_gpio_rx 1.30
Device Driver Interrupt Controller (IRQ) r_irg_rx 1.30
Device Driver Multi-function pin controller (MPC) r_mpc_rx 1.30
Device Driver Ethernet controller PTP controller (EPTPC) r_ptp_api_rx 1.01
Device Driver Quad serial peripheral interface (QSPI) r_qspi_smstr_rx 1.06
Device Driver Serial peripheral interface (RSPI) r_rspi_smstr_rx 1.06
Middleware M3S-S2-Tiny (ADPCM encoding/decoding library) r_s2_rx 3.01
Interface M3S-T4-Tiny socket APl module r_socket 1.10
Device Driver Sampling rate converter (SRC) r_src_api_rx 1.00
Device Driver Serial Sound Interface (SSI) r_ssi_api_rx 1.00
Middleware M3S-T4-Tiny interface conversion module r_t4_driver_rx64m 1.00
Middleware M3S-T4-Tiny (TCP/IP protocol stack library) r_t4 rx 2.00
Middleware M3S-TFAT-Tiny (FAT file system) r_tfat_rx 3.00
Device Driver USB basic firmware r_usb_basic 1.00
Device Driver USB host communication device class r_usb_hcdc 1.00
Device Driver USB host human interface device class r_usb_hhid 1.00
Device Driver USB host mass storage class r_usb_hmsc 1.00
Device Driver USB peripheral communication device class r_usb_pcdc 1.00
Device Driver USB peripheral mass storage class r_usb_pmsc 1.00

Note: This package include the M3S-T4-Tiny (TCP/IP protocol stack library) of evaluation version. For the
commercial version, please go to the below URL.
http://www.renesas.com/mw/t4
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4. Usage Procedures

The RX Driver Package allows programs to be easily constructed by using the FIT plugin included in e? studio. The
remainder of this section presents a simple usage example using e’ studio. To use CubeSuite+, see the document “RX
Family Adding Firmware Integration Technology Modules to CubeSuite+ Projects (RO1IAN1826EJ)” included in this
package.

4.1 Environment Used

The RX64M is used as the target microcontroller and the Renesas Starter Kit+ RX64M is used as the target board. If a
different environment is used, replace the specifics used in the example with the ones for that environment as you read.

4.2  Install RX Driver Package in e® studio
Install the FIT modules in the RX Driver Package into e? studio.

1. Decompress the downloaded file an_r01an2144ej0100_rx64m.zip into an arbitrary directory.

2. Open the folder that was decompressed and open the FITModules folder in that folder.

3. Select all the files in the FITModules folder and click Copy in the Edit menu.

= Eol =)
@Qv‘ + an_r01an7144ej0100_pédm »+ FITModules » ~ [ #3|[ Search Fimtodutes o
Eile| Edit [¥iew Ioolzs Help
Organize + 23 Open  Sharewith Bumn  Mewfolder 5~ [ @
2 Favorites * [ bspv260xml 1. v_gspi_smstr_n v1.06.zip = r_ush_hedc v1.00:4ml
1 r_bsp_v2.60.zip ] r_rspi_smstr_n_v1.06.xml 4 r_usb_hcdc_v1.00.zip Select a” f||es and C“Ck
B Deskto £ || emt_pcv230.aml 1, 1_rspi_smstr_nc v1.06.zip =1 r_ush_hhid v1.00.xml i .
= L‘b,a:es 1, r_cmt_nv2.302ip [ r_s2_m v3.0Lxml 1, r_usb_hhid_v1.00.zip Co Py In the Edit menu.
) Documents | r_dmaca_p_vl Oxml 1,r.s2_ncv3.0Lzip =/ r_usb_hmsc_1.00.xml
o) Music 1,1_dmaca_n vl 0.zip | r_socket v1.10uml 1 r_ush_hmsc v1.00.zip
=] Pictures =] r_dte_n v2.00.xml i) r_socket_v1.10.zip 1= r_usb_pcde_v1.00.xml
Subversion 1, r_dtc_nv2.00.2ip [ r_src_api_n v1.00xml 1, r_ush_pcde v1.00zip
H Videos %] 1_ether_p_v1.00.xml 1, r_src_api_n_v1.00.zip | r_usb_pmsc_v1.00.xm|
B 4, r_ether_m _v1.00.zip (=) r_ssi_api_m_v1.00.xml 1, r_usb_pmsc_v1.00.zip
18 Computer | r_gpio_n_vl.30.ml 1, v_ssi_api_nv1.00.zip
€ Network 1y r_gpio_r¢_v1.30.zip (] r_t4_driver_n64m_v1.00xml
@ Control Panel | r_irq_nc130xml 1, r_t4_driver_nédm_1.00.zip
& Recycle Bin 4 r_irg_nc vl 30.zip = r 4 n v2.00xml
an_r012n2144&j0100_né4m = r_mpe_pvl30xml {7 t4_n v2.00zip
FTModules 1,1 mpc_n vl.30.2ip =) r_tfat_n v3.00.ml
T 1 bsp v260zip | r_ptp_api_r_v1.01xml 4 r_tfat_n v3.00.zip
% r_cmt e v2302ip 1, r_ptp_api_ 101 zip = r_ush_basic_1.00xml
4 r_dmaca_nv1.01zip =] 1_qspi_smstr_nc v106xml | || {1 usb_basic v1.00.zip
e dbe e 200 5in A
48 items selected
“ Show more details...
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4. Open the e? studio install folder (Usually, this will be c:/Renesas/e2_studio.) and open the FITModules folder in

that folder.

5. Click Paste on the Edit menu.
The e? studio FITModules folder will be copied to the FIT modules.

[E=8 ol 5
@Qv‘ . » Computer » Local Disk (C:) » Renesas » e2_studic » FITModules » - ‘C,ll Search FiTModules Pl
E\IEIEL' Fools—Help
Organize v 23 Open Burn MNew folder ¥+ 0 @
— * [2]rbspv260xml 1, r_gspi_smstr_n11.06.zip = r_usb_hedc_v1.00xml
1, 1_bsp_v2.60.zip =] r_rspi_smstr_nc v 06axml 1, r_usb_hcde_v1.00zip
g =] r_emt_ne_v2.30.xml 1, r_rspi_smstr_rx_v1.06.zip (= r_usb_hhid_v1.00 xml
1, r_cmt_nc v2.30zip =1 52 p 301l 1, r_usb_hhid_v1.00.zip
L ] r_dmaca_n_v1.01lxml 4 r_s2_m_v3.01.zip 12 r_usb_hmsc_v1.00.xml
LT R 3 1, r_dmaca_nc_v1.01.zip ) r_socket_v1.10xml 1, r_ush_hmsc_v1.00.zip
e — |2 r_dtc_m v2.00aml 1, r_socket v1.10.zip =1 ush_pedc v1.00ml
-y 1 r_dtc_rx_v2.00.zip =] r_sre_api_rx_v1.00 xml 4 r_usb_pcdc_v1.00.zip
' =] _ether 100l 1, r_sre_api_nv1.00.zip /1 ush_pmsc v1.00xml
L J 1, r_ether_nc v1.00.zip = r_ssi_epi_pv1.00.xml 1, r_usb_pmse_1.00.zip
Renesas =|r_gpio_n_v1.30xml 1, r_ssi_api_ncv1.00.zip
i 1, r_gpio_m_v1.30.zip /v t4_driver_n64m v1.00xml
e &) r_irg_r¢_v1.30.xml 1 r_td_driver_n®4m_v1.00.zip
. &2 studio 1, rirq_ne v 30.zip =] r_t4_nc v2.00xml
DebugComp = |r_mpe_n_vl30xml 1,7t _nev2.00.zip
Drivers 1y _mpec_nvl 30.zip =] r_tfat_m_v3.00.xml
eclipse =|v_ptp_api_n v1.00aml 1. r_tfat_nx v3.00.2ip
ste 1y r_ptp_api_re v1.01.zip [ r_usb_basic_v1.00.xml
FITMedules = [T_gepi_setr_rx L 6T T T_usb_basic_vI00Zip
internal -
48 items selected
('8 Show more details...

4.3 Application Creation
In this section, create a simple application that drives an LED.

4.3.1 Create a Workspace and a Project
First, create a new workspace and a new project.

1. Start e? studio.

2. Enter an arbitrary workspace folder in the displayed dialog box and click OK.

Workspace Launcher

Select a workspace

e2 studio stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session.

=55

Open the FITModules
folder and click Paste
on the Edit menu.

The folder will be copied.

Enter a workspace

SN [ sample vorkspac] | —Brewse—] older
[7] Use this as the default and de not ask again
| ok H—eemee—] Click OK.
RO1AN2144EJ0100 Rev.1.00 Page 11 of 31
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3. When the following window is displayed, click Workbench.

File Edit Source Refactor MNavigate Search Project Run Window Help

E‘ @ Welcome 32 |
]

—— Click Workbench.

k

4. When the workbench has started, select New from the File menu and click C Project.

Edit Scurce Refactor Mavigate Search Project Run  Window Help

New Alt+Shift+N » Renesas FIT Module
Open File... ‘ | C Project I Click here.
= -
Close CtrlsW G+ Project
= . e
Close All Ctrl+Shift= W Makefile Project with Existing Code
% Project..
|| save Ctrl+5
B | swvens. Convert to a C/C++ Project (Adds C/C++ Nature)
[ SaveAll CurteShifts |85 Source Folder
o % Folder
Ef Source File
Lo [ HeaderFile
& FRename.. F2 r_‘f File from Template
27 Refresh F5 @ Class
Convert Line Delimiters To 4 |j Task
&) | Print... Ctrl+P T9 Other.. Chil+N
Switch Workspace 3
Restart
g2y Import..
ey Export.
Properties Alt+Enter
Exit
RO1AN2144EJ0100 Rev.1.00 Page 12 of 31
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5. Enter the project name. For the project type, click Sample Project under Executable (Renesas). For the tool chain,
click Renesas RXC Toolchain. After making these settings, click Next.

C Project I?I\EI

C Project p—;

Create C project of selected type

Project name| led_sample Entel’ the

Use default location pI’Oject name.

Cihsample_workspace\led_sample Browse...

Create Directory for Project

Project type: Toolchains:
Executable (Renesas) KPIT GMUARM-RZ-EABI Teolchain
® Sample Project KPEF-GMURLTE-EEF Footehain Click here.
Static Library (Renesas) KPIT GMURX-ELH Toclchain
® Sample Project KPIT GNUSH-ELR Toolchain
Debug-Only Project Renesas | ain:
Executable

Renesas SHC Toolchain
Executable (TAR)

Shared Library

Static Library

V800 Standalone Executable (Green Hills)
VBOD Standalone Static Library (Green Hills)
VB0 ThreadX Executable (Green Hills)
Makefile project

4 | m C

Show project types and teelchains only if they are supported on the platform

@:J < Back " Mext > ” [ Finish ] [ Cancel ]

6. Select the target. Click the “...” button under Target Selection and select R5SF564MLCxFC. After making these
settings, click Next.

lef] ¢ Project = [
e2 studio - Project Generation —
Select Target Specific Settings
Toolchain Version [vZ.[]l.CI[] v] e
Debug Hardware: [El v] _%1’
Data endian : [Little-endian data '] {{“ CI|Ck here a.nd
s
Select Target: RSF56107VxFP
9 77 select
R5F564MLCxFC.
Select Configurations:
Hardware Debug ¢ Debug using hardware
Debug using Simulator : Debug using simulator
|| Release (no debug) ¢ Project without any debug infermation
Build configurations will be created in the project only for the selected debug mode
optiens, however by default the project will be built for the active configuration i.e,
first configuration selected from group. Based on the device selection you made
(RXB00) the debug hardware (E1) and debug target (RSF56107VxFP),debug
configuration will be automatically created for you.
- f — i
@ < Back e Click here.
RO1AN2144EJ0100 Rev.1.00 Page 13 of 31
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7. Simply click Next here.
C Project = =R

e2 studio - Project Generation —

Code Generator Settings

[ use Peripheral code Generator

The e2 studio peripheral code generator autematically generates programs (device drivers)
for MCU peripheral functions (clocks, timers, serial interfaces, A/D converters, DMA
controllers, etc.) based on settings entered via a graphical user interface (GUI). Functions
are provided as application programming interfaces (APIs) and are not limited to
initialization of peripheral functions.

Autornatic f 3
UART generation Application under
=] Timer of peripheral development
o function
DA | Pert settings L Middlewarz
7 Deviee 1
DMA Clack driver |

w T T T < Microcontroller

H—fimish— - —conce—1 Click here.

8. Simply click Next here.
C Project [= &=

e2 studio - Project Generation p—(
Select Additienal CPU Options

Select Additional CPU Optiens:

Round: [Nearest ']
Precision of Double: [Single precision ']
Sign of Char: [Unsigned V]
Sign of bit Field: [unsigned -]
Allocate from Lower Bit [Lower bit V]
Width of Divergence of Function: [24 Bit V]

Specify Global Optiens:
[ Denermalized number allowed as a result

[ Replace from int with short

| Enum size is made the smallest

[T Pack structures, unions and classes
[T Use try, throw and catch of C++

[ Use dynamic cast and typeid of C++

@:J < Back

i ——— } Click here.

RO1AN2144EJ0100 Rev.1.00 Page 14 of 31
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9. Simply click Next here.

] C Project o o e
e2 studio - Project Generation p—(
Global Options Settings
Patch code generation [None V]
Fast interrupt vector register: [None V]
ROM: [None V]
RAM: [None V]
Address (H'): 00000000
Address Register: [None V]
- f m— i
@ [ <Back e Click here.
10. Select C(C99) under Library Structure and click Next.
] C Project o e
e2 studio - Project Generation
Standard Header Files
Library cenfiguration: |5C(C99] I : } Select C(ng) .
Select Header Files:
runtime : Runtime routines (Checked and disabled by default)
[ etype.h : Character classification routines
[] math.h : Mathematical/trigonometric operations{double-precision)
|| mathf.h : Mathematical/trigonometric operations(single-precision)
[ stdarg.h : Variable argument functions
stdio.h : Input/Qutput
[¥] stdlib.h : General purpose library features
string.h : String handling cperations
[ ios(EC++) : Input/Output Streams
new(EC++) : Memary allecation and deallocation routines
[] complex{EC++] : Complex number operations
[ string(EC++) : String manipulation operations
() complexh(C39) : Performs complex number calculation
[ fenv.h(iC03) : Sets floating peint environment
[Jinttypes.h(C99) : Converts integer type format
[ wehar.h(C33) : Performs wide character
|| wetypeh(£99)  : Performs wide character conversion
Select All || Deselect All
3 . N H
@ <Back || Net> |H—finism—H—eomce—] Click here.

RO1AN2144EJ0100 Rev.1.00
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11. Clear all four check boxes and click Finish.
C Project ?@

e2 studio - Project Generation —

Set various Stack Areas and to add additional Supporting Files

Sta_ck.-’Heap Configuration
[T Use User Stack C|eal’ a” the
Usdr's Stack Size: () [100 check boxes.

I

5

tarrupt Stack Size: (H) 300

[] Jse Heap Memory
Hegp Size: (H) 400

engration of Supporting Files
|| Vector Definition Files

o

Generate Hardware Setup Function | Mone

©) Neto[_gnish H—conee—] Click here.

12. Click OK. The project will be generated.

Summary @

Project Summary:

-------- PROJECT GEMERATOR -------- -
PROJECT MAME: led_sample

PROJECT DIRECTORY : Cihsample_workspace\led_samp

CPU SERIES : RX600

CPU TYPE: RXB4M

TOOLCHAIN MAME : Renesas RXC Toolchain

TOOLCHAIN VERSIOM :  v2.01.00
GEMNERATIOM FILES :

Chsample_workspace\led_sample\srctled_sample.c
Main Program

C\sample_workspace\led_sample\srcidbsct.c
Setting of B and R sections

C\sample_workspace\led_sample\src\typedefine.h
Aliases of Integer Type

£] L} 3

Click OK to generate the project or Cancel to abort.

ok JH—eamee—d Click here.
R0O1AN2144EJ0100 Rev.1.00 Page 16 of 31
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4.3.2

Prepare to Embed the FIT Modules

Since the FIT modules are independently initialized in BSP, it is necessary to modify certain aspects of the project

generated by e” studio.

1. In Project Explorer, delete the dbsct.c and typedefine.h files in the src folder.

/s - 2 stusio e
File Edit Source Refactor Navigate Search Project Run  Window Help
i | $-& oW 20 6 g G B0 WSS T
v v - v| # Quick Access ﬁ’l Eg C/C+
[ Project Explorer 52 = 0 = 0 Brom = 0
B %‘ » v gy v
4 125 led_sample [HardwareDebug] An outline is not available.
> [mi Includes
4 (8

| [ typedefine.h

G custom bat

< n

|2 led_sample Debug.launch

@ 2 items selected

|2 led_sample HardwareDebug.lau

Hcod. m = 8

Delete these files.

2. In Project Explorer, click Project and open the properties by clicking Renesas Tool Settings in the toolbar.

CfC++ - 2 studio

I Project Explorer &2

Search Project Run

I 2Lt =R

Window Help

File Edit Scurce Refactor MNavigate
T~ | B~ |~ |l

| Renesas Tool Settings (Alt+T) i

Eh-3K

Al =% led_sam ple [Hardware[}ehug]l

=

> [ Includes
PFRERT

+ [g led_sample.c
custem.bat
|=| led_sample Debug.launch
=| led_sample HardwareDebug.lau

Click here.
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3. Click Settings under C/C++ Build in the properties and click Section under Linker.

Properties for led_sample =g Eoh )|
type filter text Settings s A4
> Resource
Builders Configuration: |HardwareDebug [ Active ] ~| [Manage Configurations...] —
4| C/C++ Build
Build Variables
Change Toolchain Vers
Depefdmy Sean ) Tool Settings | - Build Steps | ' Build Artifact | [y Binary Parsers | @ Error Parsers
Device 4 8 Compler
Environment 4 (% Source Sections viewer:
Logging =
& Source file Adelre Section Name i
[Settings | — Click here.
Tool Chain Editor @ List 000000004 suU
. C/C++ General + (B Optimize st
Project References @ Advanced B1 =
Run/Debug Setting= (8 Miscellansous R1
» Task Repository B User B2
4 (®CPU R2
(% Advanced B Add Section
(2 PIC/PID R
4 15 Assembler 0xFFC00000 PRecetPRG
(22 Source c1
Q@ Advanced c
O List o5
5 Wicellneous o -
|  User W
4 [ Linker L
PIntPRG
Defines .
3 Advanced -
@ TR = BACERRAEST Click here.
+ & dptimize OxFFFFFFFC RESETVECT
i Advanced
IES:E' [ Override Linker Script: Browse
= Symbol file WS
)
[} T 4 User =
®

4. In Section View, delete PResetPRG and PIntPRG. Click each section and click Delete Section.
Also, the P section must be changed to P*. Click the P section and modify it to be P*.

Sections viewer:

Address Section Name
000000004 su

s

B1

R1

B2

R_2

B

R
(0xFFC00000 Remove Section

c1

c2 MovE Up
C

;fk Mowve Down | 4

wr Click here.
L

%RG Modify this

OxFFFFFF80 EXCEPTVECT to be P*.
OxFFFFFFFC RESETVECT

m

Add SEetion Click here.

[] Override Linker Script: Brows

T ox H—eme—] Click here.
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5. Add an OPT_MEMORY section after the C section. Click the C section and click Add Section. Click the added
section, NEW_SECTION_1, and modify the name to be OPT_MEMORY.
After completing the modification, click OK.

Sections viewer:
Address Section Name
(000000004
- Click here.
Add Section
0xFFC00000
[ Mowlp | Modify this
E to be
o L OPT_MEMORY.
W
L
p*
0xFFFFFFE0 EXCEPTVECT
0xFFFFFFFC RESETVECT
[ Override Linker Script:
[ ok  H—emee—} Click here.
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4.3.3 Install the FIT Modules with the FIT Plugin.
Install the required modules with the FIT plugin into the created project.

Here, install the BSP module (r_bsp) and the compare match timer driver (r_cmt_rx).

1. In the File menu, select New and click Renesas FIT Module.

C/C++ - €2 studio
Edit Source Refactor Mavigate Search Project Run  Window Help
New Alt+Shift+N » | [€Renesas FIT Module I 2 Click here.
Open File... @ C Project
Close Cirl+W B Ces p_mJE(t_ _ o
Clase All Ctrle Shifts W B Makefile Project with Existing Code
4 Project..
Save Ctrl+§
Save As Convertto a C/C++ Project (Adds C/C++ Nature)
ve As.. -
Save All CtrleShiftss | B85 Source Folder
Revert % Folder
¢ Source File
RS K Header File
 Rename.. F2 % Filefrom Template
& Refresh F5 @ Class
Convert Line Delimiters To 3 & Task
U Cll+P 1 =4 Other... Cirl+N
Switch Warksnace v L
2. Select the created project with Project to Add FIT Module to.
Next, select RX64M under Group and select RSKRX64M from Target Board.
Next, click r_bsp and r_cmt_rx in the module list and click Finish.
le? Add FIT Module =R ECE
FIT Modules
Select FIT Modules to add to the selected project
MName of the project to add FIT modules: | led_sample Select the pl’OjeCt
Family Any | Target Board RSKREG4M - | Function  Any A
Series  Any - Toolchain Any - Application Any -
Group RY64M ~ freset Select this item.
Module Version  Description it
r_bsp 260 Board Support Packages, I = C||Ck hel’e_
r_byteg 110 Byte-based circular buffer library.
i rcmt_m 2.30 Simple CMT driver for creating timer tick, :
r_dmaca_rx 1.00 DMACA driver
r_ether_nc 1.00 Ethernet Driver.
r_gpio_rx 1.30 General Purpose Input/Output Driver
r_irg_nc 130 IR Driver
r lonag 110 Unsigned 32-bit circular buffer library. i
Details
Dependency: r_bsp version(s) 2.30, 2,60 E
This module creates a timer tick using a CMT channel based on a frequency input by the user, R¥110 and
RX64M require a BSP compliant with r_bsp v2.50 or higher, All other supported MCUs can use r_bsp v2.30
ar higher.
@) |[ Finish ]l [ Cancel
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3. Click OK with changing anything.
(i) Project Updated @

Paths for C Includes and Source Locations have been updated.

Press OK to continue

] Click here.

—Eamcet—

[ ok

4. Click OK with changing anything.

Properties for led_sample

= ==

| Paths and Symbols

> Resource

Builders

ChCan Build Configuration: [HardwareDebug [ Active ] =] [Manage Configurations...

a C/C++ General
» Code Analysis

Documentation {3 Includes [ # Symbols | E3 Source Location | ] References
File Types
Formatter Languages Include directories
Indexer GNU C (= ${TCINSTALL}include
Language Mappings GNU C++ 2 /${ProjName}/r_bsp
Paths and Symbels Assermbl > . T -
by J5(ProjN. Vi fi Delete
Preprocessor Include Pz gﬁ;l’:}N::::ﬁ:ﬁ:’; 'fx -
Project References - N -
RunDebug Sestings {2 /${ProjName}/r_cmt_nefsrc
» Task Repasitory T
ove Up

Move Down

@ "Preprocessor Include Paths, Macros etc.” property page may define additional entries

Show built-in values

[ 8 import Settings...| [ G Export Settings..

Restore Defaults Apply

@ Click here.
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5. Open r_bsp/board/rskrx64m from the e’ studio Project Explorer, select the two files r_bsp_config_reference.h
and r_bsp_interrupt_config_reference.h, and click Copy on the Edit menu.

C/C++ - &2 studio

I~ Rofact Y e n—

Select these two files

I ool |

File | Edit

a == led_sample [HardwareDebug]
» [ Includes
a B r bsp
4 [= board
4 [= rskrddm

» [ dbsct.c
» [ hwsetup.c
> [B] hwsetup.h
o ] lowhvl.c
» [ lowsre.c
. [0 lowsre.h

I3

Ll

(=}

£} Havig Sea jeet W P .
s | &= &~ Gl Zia w6 and click Copy on
= I v | the Edit menu.
[ Project Explorer 52 E|<;==;>| & ~ = 8

> | [ r_bsp_config_reference.h
> | [h] r_bsp_interrupt_config_reference.h

> [h] r_bsp.h

Select r_config from the e? studio Project Explorer and click Paste on the Edit menu.

C/C++ - € studio

c

Select the r_config

b n ITTR

P T TR—
Fefacter—Mavigat

|[® -/~

-

File | Edit

e
T

=

- - v | =

orer 51
mple [HardwareDebug]
ludes

P

nt_r

[ Praject Exp
4 =5 led_sal

> [l Ind

> @ r_H

> B rc
PREE-
[]|led_sample.c

4 |[= r_config
r_bsp_config_reference.h

In| r_cmit_re_config.h
readme.txt
custom.bat

|Z| led_sample Debug.launch

B&| s

|=| led_sample HardwareDebug.

1

c 4
rear f et

A

T

T

folder and click Paste

Prej
heRd i
on the Edit menu.

= =

O

Ik| r_bsp_interrupt_cenfig_reference.h

launch

Change the names of the two copied files to r_bsp_config.h and r_bsp_interrupt_config.h. That is, delete the

“ reference_” part of the file names.
C/C++ - &2 studio
File Edit Source Refactor MNavigate Search Project Bun  Window He
e | &~ &/~ @ i e e
- - - v| #
[ Project Explorer &2 = <f{>| o T =08

a = led_sample [HardwareDebug]
> [ Includes
> 3 r_bsp
s 2 r_emt_m
4 [ src
» [ led_sample.c
4 [= r_config

I r_bsp_config.h

I r_bsp_interrupt_config.h

Rename these files.

Ia| r_cmt_rx_config.h
readme.tat
custorn.bat

|=| led_sample Debug.launch

|=| led_sample HardwareDebug

Jaunch
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8. Modify platform.h to correspond to the target board used.
Double click r_bsp/platform.h from the e? studio Project Explorer and, in the editor, remove the comment from
the include line for the r_bsp.h file for the RSKRX64M.

[ Project Explorer &2

a = led_sample [HardwareDebug]
> [ Includes
a 2 r_bsp
> (= board
> = doc

= 0

=& s

-

Woh G

[n] *platform.h 52

129

= /* RSKRXB3T_B4PIN */
//#include "./board/rskrx63t_64pin/r_bsp.h"

= /* RSKRXG3T_144PIN */
//#include . /board/rskrx63t_l44pin/r_bsp.h"

= /* RDKRXG3N */

//#include "./board/rdkrx63n/r_bsp.h"

> = mcu
»| [l platferm.h
=] readme.td

- 2 r_emt_rx
4 2 =rc
> €] led_sample.c
4 [= r_config
In| r_bsp_config.h
In| r_bsp_interrupt_config.h

=
3
3
3
34
3
3
=]

= KURRABSL

//#include . :.f'bc:a’d_.f"dk’x631_!"_bsp -h"

/* RSKRXG4M */

Double click.

#include "./board/rskrxédm/r_bsp.h" |— RemOVe the comment.

= /* RSKRX21@ */

//#include "./board/rskrx218/r_bsp.h"
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434 Create an LED Driving Program
Create a program that toggles the LEDO on/off state every 0.5 seconds using the compare match timer.

Open the file src/led_sample.c and modify it as shown below.

src/led_sample.c

/***********************************************************************/

/* >/
/* FILE :Main.c or Main.cpp */
/* DATE :Tue, Oct 31, 2006 >/
/* DESCRIPTION :Main Program */
/* CPU TYPE : */
/* >/
/* NOTE:THIS 1S A TYPICAL EXAMPLE. >/
/* >/
Y falsiaiaiaiaidaisisiaiaiaiaidasisiaiaiaiaisasisisiaiaiaiaiasisisiaiaiaiaiassisisiaiaiaiaisaiaisiaiaiaiaiaaiasiaiaiaiaiaiaiaiaiaioiata /

#include "platform.h"
#include "r_cmt_rx_if_h"

/* LED Currently status */
uint32_t ledstatus = LED OFF;

void call_back(void *pdata)

{
if (ledstatus == LED OFF)

{
/* Turn ON the LEDO If the status is LED_OFF */
LEDO = LED_ON;
ledstatus = LED ON;
}

else

{
/* Turn OFF the LEDO If the status is LED ON */
LEDO = LED_OFF;
ledstatus = LED OFF;
}
}

void main(void)

{
uint32_t cmt_ch;

/* LEDO off */
LEDO =LED_OFF;
/* Create of 0.5 second(2Hz) cyclic timer. */
R_CMT_CreatePeriodic(2, &call_back, &cmt _ch);

while(1);
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435
Build the program just created and verify that it runs.

1. Click Build Project on the Project menu.

Build and Try Running the Program

2 studio

Search |Project | Run  Window Help

iE Dﬂ Open Project “3 v Q-
Close Project

= 0

— | lmp Build Al Ctri+B v poee
Build Configurations (3N LED
Buid-Praject
Build Working Set b |E ‘;Li‘“ B
Clean... = LED.O
Build Automatically
Renesas Quick Settings Alt+Q e LED® °
Update All Dependencies Alt+D D OFF;
Make Target p | = HERY
C/C++ Index 3
Properties
58 wint32.t cmt_ch;

52 /= LEDB off =/

Click here.

2. When the build completes, the following will be displayed in Console view.

[3_\ Problems é, Tasks [ Conscle 32 | Properties Memory Usage |E| Stack Analysis

CDT Build Console [led_sample]

C:\Renesas\E22FCB~1\DEBUGC~L\RX\RX_CON~1.EXE led_sample.abs led_sample.x

Leading input file led_sample.abs
Parsing the ELF input file.....

25 segments required LMA fixes
Converting the DWARF information....
Constructing the ocutput ELF image....
Ssaving the ELF cutput file led_sample.x

'Build complete.’
17:31:13 Build Finished (tock 19s5.594ms)

4| 1 |

3. Click Debug Build on the Run menu.

Project Window Help

woE @, Run Curl+F11 [ o o=
*, Debug F11
- Run History 3
- Run As »
34
35 Run Configurations...
36 status i
37 Debug History 4
;3 Debug As » ]
48 Debug Cenfigurations... C||Ck here.
—E Toggle Breakpoint Ctrl+5hift+B status
2 Teggle Line Breakpoint
45 Toggle Method Breakpoint
:E Toggle Watchpoint
2z | s Skip All Breakpoints
f: Remove All Breakpoints
2
51 Breakpoint Types ]
% External Tools »
[Z1 Problems % Tasks | Bl Console 32 | ] Properties Memory Us
RO1AN2144EJ0100 Rev.1.00 Page 25 of 31
Sep 1, 2014 RENESANS



RX64M Group

RX Driver Package User's Manual

4. Click led_sample HardwareDebug under the Renesas GDB Hardware Debugging. Click the Debugger tab and

click Connection Setting.

Modify EXTAL Frequency to be 24.0000 and change Provide Power from Emulator to No.

When these changes have been made, click Debug.

Debug Configurations

Create, manage, and run configurations

DTEX| B

Name: led_sample HardwareDebug

type filter text [l main ﬁ: Debugger B Startup | Bz Source| = Common
Debug-only
H
[€] GDB Hardware Debugging Debug-hard El ForgetD | RSESELMIL CIICk here
GDE Simulater Debugging (SH, RLTE
i GHS Local C/Ce+ Leundh | GDB Settings|| Connection Settings | Debug Tool Settings |
% Renesas GDB Hardware pttach
Fl Renesas GDB Hardware Pebuggin 4 Uack
9 Main Clock Source EXTAL - H
[£7] led_sample HardwareDebug Extal F [MHz] 24,0000 MOd'fy tO be
- al Frequency[MHz !
> &7 R Simulator Deb R
enesas Simulator Debugging (RX o Permit Cleck Source Change On Writing Inte Yes - 240000
4 Connection with Target Board
Emulator (Auto) [
Connection Type ITag -
ITag Clock Frequency[MHz] 165 -
Fine Baud Rate[Mbps] 2.00 -
Hot Plug Mo -
a Power
Power Target From The Emulator (MAX 200n{No M0d|fy to be No.
Supply Voltage 3.3V -
4 CPU Operating Mode
Register Setting Single Chip -
Maede pin Single-chip mode -
4 Communication Mode
Maode Debug Mede -
Execute The User Program After Ending The[ Mo -
4 | 1] k [ ] [
Appl Revert
Filter matched 8 of 13 items PPl EVEl
@ [ pebug  H—cowe Click here.
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5. When the following message is displayed, click Yes.
Confirm Perspective Switch

(e

This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint
management.

Do you want to open this perspective now?

[] Remember my decision

6. When the load module download completes, a Debug perspective opens.

Click here.

(07 Dty - beel_samples_bisgy/bsrd/vakibbm/eeselpeg.c - 2 studin
File ~ Edit Source Refactor Mavigate Search  Project Bum  Windew Help

i [E=R RO RO N TR s e e A 2

uick Access m

led sample HargwareDebug [Renesas GOB Hardware Debugging] gdb
anitor set_lo_aceess width, i 2

monitor set_lo_sccess_width
monitor set_ie_sccess_width,

366-9036d, 98I76-5037d, 90186-9036d, 59396 -9035d, 98386 -593ad, 900G -S00bd, F83cE-903cd, SROME
225-9122d,91256-91234, 91246 -91 284, Y1 256-9125d, 91266-9126d , 91276-9127d, 91 206-9128d, 912

85 -9028d, I0296.- H29d, 0228 - A02ad, WFHE 902k, 9026 - G0Tcd, ANIAE- H02dd, G075 - I02ed, H2FS - 902Fd, I0I0E- Ka10d, I0I1E- 9031, FI2E 903 2d, HA3I6-9033d, IAI4E- 50344, 90«
3dd, 9@3e6-503ed , 903F5-900Fd, 50020-9003F , 50845-90653,

G cics+ [rDetug

i 12)
HE Dby 50 LY P |t YEN 195 Warakile: -
a [E7 ed_sample HardwareDebug [Renesas GOB Herd & o
o 18 el _semples Harne Type Value
4 Theead [1]1 (Mo thread infio available) (Suspeneled : Sigral: SIGTRAP-Trace/hreakpaint trap)
= Pewer(N_Beset PC() at resetprg,c122 Oeffed1 el
il gdb
il GDB server
=.0 57 Cutline 53 il -
1 g o 4 s E R ok T
M _heinh .
4 o E # BSP_DFCLARE STACK
o ffeuniel  wvoid PowerON_Reset_PC{void) U pletfoemb
. { # PSWint
func . & :
# FPRW_nt
27 ffeal 76 o _INIT_IOUB vond)
1 i LOREALL fveid)
In the Cxception Table W TS
10 ffeoriff set_extb(({void *)__sectop( LXLLPTVECT")); W my tan te fun
! ¥+ PowerON Reset PCiveid) v
[ Console 37 ) Tasks 3 Renses Coverage [ Memory Usege (7 Performance Analysis O Profile ¥ Real-time Chart 8 Trace () Visush Expression [ Problems (3 Executables (] Memony =N
x| GRBEPE R -

856, $1206-91
2ek-uled

monitor set_io_sccess_width,kw
]

S91386-9130d, 91316-5131d, 91326-9132d, 91 336-9133d, 91 34491 3ad

9d, 912ak-9120d, 912b6-913bd, 912ch-912cd, 912d6-912dd,
7d, 91386-5138d 5-913%d, 91385-913ad, 913b6-9130d,

1356-9135d, 91 366-9136d, 913 Jck-913cd

Click Restart on the toolbar. The program will be executed and a break will occur at the start of the main function.

Debug - led_sample/r_bsp/board/rekrédm/resetprg.c - e studio

File Edit Source Refactor Mavigate Search Project Run  Window Help
il |8 -Q- 5 R H 790 $-0-%- \[E}—==
35 Debug 52 %'%%@W|i‘=ﬁ>

4 [ led_sample HardwareDebug [Renesas GDB Hardware Debugging]
a 1 led_samplex
a4 Thread [1]1 (Mo thread info available) (Suspended : Signal : SIGTRAP:Trace/breakpoint trap]
= PowerOMN_Reset PC(] at resetprg.c:122 0xffc017e8
o gdb
p| GDB server

[€] resetprg.c B2

8. After the break at the start of the main function, click Restart on the tool bar again.
The project will be run and the program will iterate toggling LEDO with a period of 0.5 seconds.

Click here.
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5. RX Driver Package Application

5.1 RX Driver Package Application Structure

The RX Driver Package Application is a sample application program provided so that users can use the RX Driver
Package easily. The RX Driver Package Application consists of an application program that operates using device
drivers and middleware included in the RX Driver Package and a project file for building that application. This allows
users to start evaluation quickly.

RX Driver Package Application

| Sample application program I | Project”e l

Figure 5.1.1 RX Driver Package Application Structure

Renesas plans to release a variety of types of this RX Driver Package Application in the future, such as system
programs that operate using a combination of multiple drivers and middleware and evaluation programs for independent
modules from the RX Driver Package.

Network server

and cliant Camera control program Audio player (ADPCM)

i ; ; Image and video
Device driver evaluation -

Boot loader middleware control
program program

Boot loader RX Driver Package
Application

Figure 5.1.2 Types of RX Driver Package Application

5.2 RX Driver Package Application Features
The RX Driver Package Application has the following features.

o The RX Driver Package Application is evaluated in combination with the RX Driver Package.

o Project files are included in the RX Driver Package Application. Since both build and debug configurations for the
application project are already set up in the provided project file, the user can quickly begin building and evaluating
simply by importing the project into a workspace.

e Ife?studio is used as the integrated development environment (IDE), the device drivers and middleware used in the
application project can be automatically added to the project by using the FIT plugin provided with e studio.

e Renesas provides the RX Driver Package Application without charge.
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5.3 RX Driver Package Application Usage Example (when e? studio is used)

The device drivers and middleware required by the RX Driver Package Application are automatically added to the
project by the FIT plugin, which comes with the e? studio.

After the project provided with the RX Driver Package Application has been installed in an e? studio workspace, the
required device drivers and middleware from the RX Driver Package are also installed simply by installing in the
project by selecting the RX Driver Package Application with the FIT plugin. Therefore all that remains is to build the
project and start evaluation.

e2 studio

FIT plugin

RX Driver Package Application
Workspace

Project

RX Driver Package

) )

Figure 5.3.1 FIT Plugin Automatic Installation

54 When Using in Combination with an RX Driver Package Application

See the document provided with each RX Driver Package Application for detailed usage methods for that RX Driver
Package Application.
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6. System Structure
The figure below shows the structure of a system that uses the RX Driver Package.

RX Driver Package Application

RX Driver
Package
e2 studio
V3.0
CC-RX
{_occ ]
AR |
Standard
components | |  |\_____(UITRON, FreeRTOS, etc) = ). Support
tool
oot b
1 Option !
[ ——— ’

I D —

-

PP —— F S —

i Third party H [ . I l

1 - E1l, E20
evaluation board ! Renesas evaluation board '

Note: * Items marked with an asterisk are under development.

Figure 6.1 System Structure

7. Supplement

7.1  M3S-T4-Tiny (TCP/IP protocol stack )

This package include the M3S-T4-Tiny (TCP/IP protocol stack library) of evaluation version. For the commercial
version, please go to the below URL.

http://www.renesas.com/mw/t4
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Website and Support

Renesas Electronics Website
http://www.renesas.com/

Inquiries
http://www.renesas.com/contact/

All trademarks and registered trademarks are the property of their respective owners.
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General Precautions in the Handling of MPU/MCU Products

The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that
have been issued for the products.

1.

Handling of Unused Pins

Handle unused pins in accord with the directions given under Handling of Unused Pins in the manual.

— The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin
in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an associated shoot-
through current flows internally, and malfunctions occur due to the false recognition of the pin state as an
input signal become possible. Unused pins should be handled as described under Handling of Unused Pins in
the manual.

Processing at Power-on

The state of the product is undefined at the moment when power is supplied.

— The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are
undefined at the moment when power is supplied.

In a finished product where the reset signal is applied to the external reset pin, the states of pins
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at
which resetting has been specified.

Prohibition of Access to Reserved Addresses

Access to reserved addresses is prohibited.

— The reserved addresses are provided for the possible future expansion of functions. Do not access these
addresses; the correct operation of LSl is not guaranteed if they are accessed.

Clock Signals

After applying a reset, only release the reset line after the operating clock signal has become stable.

When switching the clock signal during program execution, wait until the target clock signal has

stabilized.

— When the clock signal is generated with an external resonator (or from an external oscillator) during a reset,
ensure that the reset line is only released after full stabilization of the clock signal. Moreover, when
switching to a clock signal produced with an external resonator (or by an external oscillator) while program
execution is in progress, wait until the target clock signal is stable.

. Differences between Products

Before changing from one product to another, i.e. to a product with a different type number, confirm

that the change will not lead to problems.

— The characteristics of an MPU or MCU in the same group but having a different part number may differ in
terms of the internal memory capacity, layout pattern, and other factors, which can affect the ranges of
electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of
radiated noise. When changing to a product with a different part number, implement a system-evaluation test
for the given product.
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use of these circuits, software, or information.

others.

the Incorporation of thess clrcults, software, and Information In the deslign of your equipment. Renssas Electronics assumes no responsibllity for any losses Incurred by you or third partiss arising from the

2. Renesas Electronics has used carein ing the i ion included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics
assumes no llabliity whatsoaver for any damagas Incurrad by you resulting from arrors In or omisslons from the Information Included heraln.

3. Renesas Electronics does not assume any liability for infrir of patents, i or ather i property rights of third parties by or arising from the usa of Renesas Electronics products or
technical i i in this No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Elecironics assumes no responsibility for any losses incurred by you or

d products and icati You are fully ible for

range, movement power voltage range, heat radiation characteristics, installation and other product istics. Renesas

third parties arising from such copy or pprop of Renesas product.
5. Renesas ics products are classified ding to the following two quality grades: "Standard" and "High Quality". The recommended applications for each Renesas Electronics product depends on
the product's quality grade, as indicated below.
" C office comm test and audlo and visual home machine tools; personal electronic
equipment; and industrial robots etc.
"High Quality": Trar tralns, ships, etc.); trafflc control systems; antl-disaster systams; antl-crime systams; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical
implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment efc.). You must check the quality grade of each Renesas Electronics product before using it
In 2 particular application. You may not use any Renesas Electronlcs product for any application for which It Is not Intended. Renesas Electronics shall not be In any way llable for any damages or losses
incurred by you or third parfies arising from the use of any Renesas Electronics praduct for which the produci is not intended by Renesas Electronics.

6. You should use the Renesas ics products il in this within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage

use of Renesas Electronics products beyond such specified ranges.

please evaluate the safety of the final products or systems manufactured by you.

no liability for damages or losses occurring as a resull of your i with i laws and

development of weapons of mass destruction. When exporting the Renesas ics products or i in this

7. Although Renesas Electronice endeavors to Improve the quality and rellabllity of its products, semiconductor products have specific characteristice such as the occurrence of fallure at a certaln rate and
malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the
possibility of physieal injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to
redundancy, fire control and malfunction pi appropriate for aging orany ather appropriate measures. Because the evaluation of microcomputer software alone Is very difficult,

8. Please contact a Renesas Electronics sales office for detalls as to environmentsl matters such as the environmental compatibliity of each Renesas Electronlcs product. Please use Renesas Electronlcs
products in i with all i laws and ions that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or
regulations. You should not use Renesas Electronics products or ibed in this for any purpose relating to military applications or use by the military, including but not limited 1o the

shall have no liability for malfunctions or damages arising out of the

regulations and follow the procedures required by such laws and regulations.

products.

(Note 2) “"Renesas Electronlcs product(s)” means any product developed or manufactured by or for Renesas Electronics.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the
cantents and condltions set forth In this document, Renesas Electronics assumes na responsibliity for any losses Incurred by you or third parties as a result of unauthorized use of Renesas Electronics

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.
(Note 1) "Renesas Electronics" as used in this documnent means Renesas Electronics Corporation and also includss its majority-owned subsidiaries.

you should comply with the applicable export control laws and
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